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[bookmark: _Toc522100130]Getting Re-introduced to Excel
Once you get to know Excel, it gets easier, and much more fun, as you realize all the neat things you can do on it.
[bookmark: _Toc522100131]Getting help and instructions from the Excel home screen
You can learn almost anything you want to do in Excel from the home screen help videos, they are very descriptive and easy to follow. They also have test samples for you to try.[image: ]
[bookmark: _Toc522099174]Figure 1 help and instructions from home screen


[bookmark: _Toc522100132]Doing formulas with numbers:
They give you step by step instructions, showing you how to do it, and then you try the steps in real time.[image: ]
[bookmark: _Toc522099175]Figure 2 doing formulas with numbers


[bookmark: _Toc522100133]Doing formulas with words:
Simply follow their instructions, it is the same method as using mathematical formulas, adding this cell to that, and putting this one first etc. only with words.[image: ]
[bookmark: _Toc522099176]Figure 3 doing formulas with words


[bookmark: _Toc522100134]Page in Excel is called a “spreadsheet” or a “worksheet”
A worksheet contains cells prearranged with columns and rows. Starting at the top left corner with row #1 and column A. Each cell can contain letters/words, numbers or formulas. (Microsoft, 2018)[image: ]
[bookmark: _Toc522099177]Figure 4 spreadsheet/worksheet sample


[bookmark: _Toc522100135]More than one “Worksheet” becomes a “Workbook”
When you have more than one “Worksheet”, it is then called a “Workbook” in Excel. Each “Worksheet has its own tab at the bottom left of the page, which you can, and should name each one individually by double clicking the “Sheet1”. To add another “worksheet” hit the plus sign beside the sheet name tabs as seen below. (French, 2018)[image: ]
[bookmark: _Toc522099178]Figure 5 workbook sample


[bookmark: _Toc522100136]Some of the things we can do in Excel:
1. Calculations
2. Reports
3. Charts
4. Analyze information
5. Enter Data
6. Make Lists to keep information organized
7. Make Templates
8. Play Games
9. And More…
(Someka Excel Solutions, 2015)
[bookmark: _Toc522100137]Some of the Templates already created for you in Excel
1. Diet – Weight loss Charts
2. Calendars- Weekly/ Monthly/ Yearly planners
3. Mortgage or Household Budget Templates
4. Percentage, and Statistical, Math Calculation Templates
5. Profit, Loss, Balance, and Cash flow Templates
(Functions.net, 2016)

[bookmark: _Toc522100138]Sample weight loss chart
You add in your information, it calculates the rest, you can also put in recipes, meal plans, shopping lists, etc. [image: ]
[bookmark: _Toc522099179]Figure 6 sample pre-made weight loss tracker chart


[bookmark: _Toc522100139]How to Enter a PDF File into an Excel Spreadsheet:
On the “Insert” tab (1), click the “Object” button in the “Text” group (2), then click the “create from file” tab (3), and hit “Browse” (4), to choose your file. If you just want a picture of the file, you choose your file, but do not hit the “link to file” (5), check box; this will put a picture of the file in your new document; however, if you want a file linked to the document you are presenting, you hit the linked button (5), then if the original file changes, it will  show the updated version in your document, because it will go to the file in real time so you are always updated, but you have to make sure you have that file available when you need to go to it.[image: ]
[bookmark: _Toc522099180]Figure 7 entering PDF into Excel 


[bookmark: _Toc522100140]How to Print Your Workbook with Page Numbers
First you have to put the page numbers in your workbook. For that you go to “page layout” (1), then go to “page set up” (2), then go to “headers and footers” (3), and hit “customize footer” (4), click on the center where you see Page 1 of 1. (5), then hit “ok” (6).[image: ]
[bookmark: _Toc522099181]Figure 8 print workbook with page numbers #1


[bookmark: _Toc522100141]Then we can print off our workbook with the page numbers
For this we need to highlight the area we want to print off first, (1), then we click the “print area” button, (2), and then the “set print area” button, (3), then you will be taken to the print screen, and you can review before you print, to make sure it is what you wanted.[image: ]
[bookmark: _Toc522099182]Figure 9 print workbook with page numbers #2
(Bethea, 2013)


[bookmark: _Toc522100142]Double check before you print
When you get to the print screen, when previewing, look at the page numbers of your whole document, such as the bottom left of the one above, it says, “Page 1 of 38”, so you want to make sure it is just printing what you want, not the whole document. (Microsoft, 2018)[image: ]
[bookmark: _Toc522099183]Figure 10 double checking before you print


[bookmark: _Toc522100143]How to Count Numbers or Categories
When you want to count a column, you start at the top or wherever you want to start the count, and click and drag your mouse, highlighting the things you want to count, see on the example, even though the highlighted names are at 20, there is only 12 on the counter, because it will not count empty spaces.[image: ]
[bookmark: _Toc522099184]Figure 11 counting numbers or categories


[bookmark: _Toc522100144]Adding up numbers without summing totals, rows, or columns
You can add up the numbers in your list as seen below, by clicking and dragging to highlight the items you want to add up, Excel will add them up and show you at the bottom.[image: ]
[bookmark: _Toc522099185]Figure 12 adding up numbers without summing total rows or columns


[bookmark: _Toc522100145]Adding numbers for quick reference, that are not together in a row
If you desire to add up a few items without adding a sum cell, and they are not all together, then you simply hit the “ctrl” button, and select the numbers one by one that you wish to add. Excel will show you the total items picked, and add them up for you on the bottom of the worksheet, as seen below.[image: ]
[bookmark: _Toc522099186]Figure 13 adding up random numbers or items


[bookmark: _Toc522100146]A few examples of where you could use a database
· Databases are everywhere; here are a few examples:
· Dr’s use them to keep track of patient information,
· they are used for scheduling appointments,
· keeping track of sales,
· keeping track of work done, or parts used, in manufacturing,
· they are used for warehousing, to keep track of what comes in and out,
· it can keep track of lots used, in order to use old stock first,
· libraries use them to keep track of books, coming in and out,
· companies use them to keep track of orders, or customers or clients,
· Facebook is a database,
· And so is Amazon.
· The list goes on; and it depends on the application it is being used for, as to how detailed it needs to be. (DatadogHQ, 2016)


[bookmark: _Toc522100147]How to Use Excel as a Database
It is easy to use Excel as a Database because it stores numbers or letters/words, making everything you are interested in easy to find, or easy to file. 
[image: ]
[bookmark: _Toc522099187]Figure 14 example of using Excel as a database #1 
https://itstillworks.com/use-excel-as-database-4451084.html 
(Bethea, 2013)


[bookmark: _Toc522100148]Excel as a Database for Contacts
Excel will hold pictures to keep on file as well, and it is easy to put contacts in and find them by company, name, or number.[image: ]
[bookmark: _Toc522099188]Figure 15 using Excel as a database for contacts


[bookmark: _Toc522100149]Using Excel to Create Forms
You can easily create forms on Excel, and update and create checkboxes for a printed version, or an online version.[image: ]
[bookmark: _Toc522099189]Figure 16 using Excel to create forms or templates


[bookmark: _Toc522100150]Creating Forms
To add your check boxes or to have drop down menus in your forms, Most of the controls you need to do that are in the “Developer” tab, in the “Controls” section.[image: ]
[bookmark: _Toc522099190]Figure 17 Forms


[bookmark: _Toc522100151]Protecting your document
Make sure you go to properties when you have chosen the control you want to put in the field you want it in, then click on the “Design Mode” and lock your text, then go to “File” and hit “Protect Document” so it cannot be changed by anyone.[image: ]
[bookmark: _Toc522099191]Figure 18 Protecting your form


[bookmark: _Toc522100152]Training Session Lesson Plan
	 
Bridge-in: Who here has more time that what they know what to do with? Ok, well then, who likes to have shortcuts to save them time? Does anybody want to share little things they do to make things easier, enabling them to save time? I would like to discuss with you how to save time with Excel, when it comes to data entry, budgeting, spreadsheets, or even just making it easier to keep track of little things in school, work, or home life.  
 

	Objective: Teach the class how to do work for home, school, and work in Excel, and how to properly use the formulas and insert other files and data to make it easy for them to calculate and keep track of any changes. 
	Date Topic: Intermediate Excel Training;
Aug. 14, 2018 
Aides Required: Excel, computer, power point, projector, 
 
 

	Pre-Test: How many of you have actually saved time with Excel at home, school, or work? 
Does anyone want to share any tips or tricks they have learned on Excel that they thought was cool, and or a time saver? 
Have the class try something individually in excel, that they feel they need practice in.
 

	

Instructor:
[bookmark: _GoBack]1) List out what areas the class needs refreshers in. 
2) Go through the slides and a sample spreadsheet, explain how to do a few things, the importance of some things, and where you might apply these applications in a real-life. 
	

Learner: 
Class
 
 
 
3) Get class to open a blank or sample worksheet, and see if they can go through the steps you are trying to teach them, to do what they think they could use some training in. 
	

Time: 

3 minutes 
 
12 minutes 
5 minutes 
 
 
 
 
 
 

	Post-test: Did the class learn the desired objective? 
Go around to see if everyone got it. 
 

	Closure and Connection: Does anyone want to share a comment if you think this will help you do home. school, or your work for your employer?  
Close with: If you create proper worksheets in Excel, it is easy to keep track of important information, and make necessary changes as needed. 
	Tips to remember: 
Talk more to audience, 
Try not to look at screen, 
Get them to try samples or create own  
Go around class to make sure everyone understood, and were able to do the steps you were trying to teach them. 
Don't forget the closing summary 
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2 Ingredients and Primary Packaging: From approved supplier address (must reference HACCP?|
2 (A) Ingredients
2 Ingredients: s there a COA for the lot #? (if no COA contact QA to place on hold)
2 Is the shipment clearly marked including - Code Date and or Lot Codel
2 Is there mixed lots on the same skid?)
2 f yes, have these been separated onto different skids?|
2% Ingredients: Kosher Symbol on labet?)





image18.PNG
B

File

@ DD 2 Record Macro

5] Use Relative References

Insert  Pagelayout Formulss Data  Review View (NN Help © Tellmewhat youwantto

[=] Propertiesg= [@ 5 Import

&1 View Code ) Expansion Packs

s Copy of AD-FO-003 receiving checklist [Compatibility Mode] - Excel

shannon stangen

Visusl Macros Bicel  COM | Insest Source
Basic & Macro Security. Add-ins Add-ins | IR Run Dialog
Code Addins Form Controls p
ofYEEe
22 = )40 8 G -
B 1 ActiveX Controls &= E F K L M N
= =154 ==
EloAlEl
2 Is there a COA for the lot #2 (i no COA contact QA to place of hold)
2 Is the shipment clearly marked including - Code Date and or R —
2 Kosher Symbol on labet?)
2 Allergen information indicated?|
Is Non- GMO Ingredient labeled with green sticker and stored segregated?)
26| 2261605 Lecithin; 2262001 Tocobiol; 2262268 Honey; 2262130 Choc Chip; 2262131 Choc Chunk
27 Contact QA when receiving 2250610 skim milk powder to confirm acceptable COA.
2 (B)_Packaging Material with Printed Ingredient Listing:
Does packaging match controlled sample for UPC, Part Number, Allergen Statement, and Key|
29 ingredeint in listing? (QAWFKOWPackaging\Packaging Verification; PK-PR-005 Labelling and Pack Control)
30 [ the above items have passed the inspection, the reviewer shallinital the form below
31 [Reviewer Initials: Verifier Initials:
2 (C) Temperature verification
3 Record trailer temperature for refridgerate ingredients.If above 4°C (39.2°F), do not off load and notify QA.|
u Liquid egg temperature: If above 4°C (39.2°F), do not off load and notify QA.|
3
36 [ the above items have passed the inspection, the receiver shallnitial the form below:
RCFO-003 | Document Changelog | (& >
Ready 8

H O Type here to search

ENG
us

224PM

2018

eu R





image19.PNG
f AD-FO-003 receving Compatibiity Mo

B oS- g

Home Insert Formulas  Data

Page Layout

Developer |[IY

Drawing

Format P Tell me what you want to do

7 Record Macro ’ 'ﬁ? B @ [=] Properties [@ 5 Import

[ Use Reltive References 3 & View Code S s
Visual Macros Bl COM Design Source
Basic 4 Macro Security Add-ins Add-ins Mode

Code Add-ins Controls L
Check Box2 ~
Format Control 70X
G H 1 J K L M N o P Q R

ColorsandLines  Size.

Do you want Locked

Lock text

{Protection]  properties

6

AltText  Control

Locking objects has no effect unless the sheet is protected. To help protect
the sheet, choose Format on the Home tab, and then choose Protect Sheet. A
password is optional —_—

7 Z

Cancel

RRRBRR B 2335 R DR DB @@ N @ ;s w N

Sheetl

| Re-Fo-003 Document Change Log | (&)

Ready

H O Type here to search

ENG
us

M
2018-08-14 X1





image2.jpeg
Excel

Recent
Pinned

Pin files you want to easily find later. Click the pin icon that appears
when you hover over a file,

This Week

Waste Water Data Chart
OneDrive » Waste Water

Last Week
Budget.
<hannon stangen's OneDrve
Budget.
OneDrive - Personal » Documents

Older

Manager-Account Query
Documer

Analysis Report chart
OneDrive - Personal » Documents

a Book

OneDrive - Personal » Documents

Open Other Workbooks

O Type here to search

earch for online template:
Suggested searches: Business Personal  Lists  Financial Management
Budgets

B

Take a
tour

felcome to Excel

Blank workbook

s

@

Get more out of

PivotTables

Get more out of PivotTables Back o School Planner

A.ﬁ

8 /%

o shannon stangen
Planners and Trackers  Chart: Switch account

Get started with
Formulas

Make your first
PivotTable

Formula tutorial

PivotTable tutorial

Student schedule Academic calendar (any year)




image3.PNG
Welcome to Bxcel(3)1 - Bxcel

Insert Pagelajout  Formulss  Data Hep O Tell mewhat youanttc

shannon stangen

S AutoSum -

=

tien 1A A - |2
B3 Copy - E3
o . 3 Find &
BIuU A 3 O nat

Clpboara 5 Font Aignment Number stytes cetis Editing ~

VLOOKUP  ~ X « fo | =SUM(D11:D15) v
A 8 c ) 3 3 G H ] K L s
1 Add numbers like a champ
2|
[l [ ——————
4] Apples 50 Beef 50
5| o Select the yellow cell under the amounts for fruit. Oranges 2 Chicken 30
6| Bananas 60 pork 10
x o Type =SUM(D4:D7), and th ter. When you're d i Lemens 2 Fish b
| ype = :D7), and then press enter. When you're done, you'll see
s
o the result of 170. L [
10 o Here's another way to add, using a shortcut key. Select the yellow cell
1 under the amounts for meat. Bread 50; Bread 50
12 Donuts 100 Donuts 100
1] o (=) first. Then, press Enter. oo P oo o
14| Cakes. 501 Cakes. 50
= o Now add only the numbers over 50. Select the last yellow cell. Type = = 20
5} =SUMIF(D11:D15,">50") and then press Enter. The result is 100. —1
17| SUM(numbert, [number2], ) \‘ EXTRA CREDIT
] . Try adding another
o . " SUMIF formula here,
0 Dive down for more detail Next step i s -
» | stat | 1.Add | 2.Fill | 3.5pit | 4 Transpose | 5.Sort&fiter | 6.Tables | 7.Drop-downs < v

point 27

H O Type here to search

ENG
us

=

5PM





